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“We can easily forgive a child who is afraid of the dark; the real tragedy of life is 

when men are afraid of the light.”  

– Plato 
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Abstract 

Colloidal lithography (CL) is nowadays considered a preferential nano/micro-patterning 

method for photovoltaic structuring, as it is an inexpensive and highly scalable soft-lithography 

technique allowing nanoscale precision over indefinitely large areas. Photonic wavelength-sized 

structures are on the top of the list of solutions that can boost photovoltaic performance 

without significantly increasing cost, as they enable pronounced broadband anti-reflection, LT 

effects, and even self-cleaning functionality. In particular, recent research suggested that these 

micro-structures can boost not only the efficiency but also the stability of the emergent 

perovskite solar cell technology. 

CL methods critically depend on the long-range ordered self-assembly that can be 

attained upon deposition of the particles’ array used as a mask, which is performed via the 

Langmuir-Blodgett method. However, it is still challenging to achieve the desired deposition 

quality particularly with the preferential polystyrene colloids with wavelength-scale dimensions. 

This thesis is focused on tackling this challenge and in the optimization of the self-assembly 

deposition of polystyrene nanospheres monolayers onto flexible substrates, as a part of a full 

CL method for photonic-enhancement purposes in thin-film solar cells. 

In this work, we report a breakthrough in our Langmuir-Blodgett (LB) method which 

prevents wavelength-sized particles from sinking into the aqueous sub-phase and spontaneously 

form the desired close-packed hexagonal monolayer. This was attained by using sodium dodecyl 

sulfate (SDS) to reduce the aqueous sub-phase surface tension and hence improve the air-water 

interface stability of polystyrene spheres of various diameters. The addition of SDS, with best 

results at 4.5 mg/l concentration, showed remarkable improvement on the self-assembly step, 

by avoiding the nanospheres sinking and by producing uniform high-quality monolayer films. 

The quality of the deposition was also improved by controlling the LB barrier closing rate and 

increasing the self-assembly work area, which resulted in fully patterned flexible substrates. 

Keywords: Light-trapping in Photovoltaics, Photonic structuring, Colloidal 

lithography, Langmuir-Blodgett, Particle Self-assembly 
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Resumo 

A litografia coloidal é atualmente vista como método preferencial para a micro e 

nanopadronização de estruturas fotónicas, já que se revela de baixo custo e com potencial de 

aplicação a largas escalas. As nanoestruturas fotónicas estão no topo da lista de soluções que 

podem assegurar uma melhoria significativa na eficiência fotovoltaica sem aumento do custo, 

permitindo efeitos de anti reflexão, captura de luz e até de autolimpeza. Estudos recentes 

sugerem que este tipo de microestruturas poderá não só beneficiar a eficiência dos dispositivos 

como melhorar a estabilidade da tecnologia emergente de células solares de perovskita. 

Esta técnica depende da área de automontagem ordenada que se obtém com a deposição 

de partículas coloidal como máscara, através de métodos como Langmuir-Blodgett. No entanto, 

revela-se difícil a deposição de partículas de poliestireno com dimensões da escala típica dos 

comprimentos de onda. Esta tese foca-se em ultrapassar este obstáculo e otimizar a deposição 

em substratos flexíveis, de modo a aplicar num método de litografia coloidal para o 

melhoramento fotónico de células solares de filme fino. 

No decurso deste trabalho, reportamos a otimização do nosso método Langmuir-

Blodgett (LB) de modo a prevenir que partículas mais pequenas se afundem, permitindo a 

formação de uma monocamada ordenada e com estrutura hexagonal, como desejado. Isto deve-

se à dissolução de dodecil sulfato de sódio (SDS) na subfase aquosa de modo a reduzir a sua 

tensão superficial, melhorando a estabilidade das esferas na interface ar-água. A adição de SDS, 

a uma melhor concentração de 4.5 mg/l, revelou melhorias significativas na automontagem, 

evitando o afundamento das nanoesferas e permitindo a produção de uma monocamada de 

elevada qualidade para a deposição. A qualidade da deposição foi também otimizada através 

do controlo do fecho de barreiras e do aumento da área dedicada à automontagem, resultando 

em substratos totalmente depositados.  

 Palavras-chave: Aprisionamento de Luz em Fotovoltaico, Estruturação Fotónica, 

Litografia Coloidal, Langmuir-Blodgett, Organização Espontânea



 

 
xii 



 

 
xiii 

Table of Contents 

Acknowledgments ............................................................................................ vii 

Abstract ........................................................................................................... ix 

Resumo............................................................................................................. xi 

Table of Contents ........................................................................................... xiii 

List of Figures ................................................................................................. xv 

List of Tables ................................................................................................ xvii 

Abbreviations ................................................................................................. xix 

Symbols .......................................................................................................... xxi 

Motivation and Objectives ........................................................................... xxiii 

Chapter I: Introduction ..................................................................................... 1 

1.1. Photovoltaic light-trapping technologies .............................................. 1 

1.2. Colloidal lithography approach ............................................................ 3 

Chapter II: Experimental .................................................................................. 7 

 Langmuir-Blodgett trough ....................................................................... 7 

 Substrate preparation .............................................................................. 7 

 Aqueous sub-phase preparation ............................................................... 7 

 PS nanospheres preparation..................................................................... 7 

 PS nanospheres deposition ....................................................................... 8 

 Characterization - SEM and ImageJ ........................................................ 8 

Chapter III: Results and Discussion .................................................................. 9 

 PS nanospheres deposition (1.3 µm size) ............................................... 11 

 PS nanospheres self-assembly (below 1 µm size).................................... 12 

 PS nanospheres deposition (below 1 µm size) ........................................ 16 

 Results Overview ................................................................................... 25 

Chapter IV: Conclusions and Future Perspectives .......................................... 27 

References ....................................................................................................... 29 

Appendices ...................................................................................................... 35 



 

 
xiv 

 



 

 
xv 

List of Figures 

Figure 1.1.1 - Schematic drawings and SEM pictures of the samples obtained after the 

different steps of the TiO2 nanostructure construction via CL: (a) a hexagonal array of colloidal 

PS spheres is patterned on the cell front, (b) O2 dry etching, (c) TiO2 is deposited, filling the 

inter-particle spaces, (d) sphere are removed leaving an array of semi spheroidal void-like 

features. The final TiO2 structure, (e) uniformly covers the entire sample area. [39] .............. 2 

Figure 1.2.1 – 3D illustration of the self-assembly of colloidal particle structures forming 

a hexagonal close-packed array (also known as honeycomb), which results in the highest in-

plane packing density – single particles tend to bond with others due to either physical, fluidic, 

external fields, or chemical force driving, from single, to small clusters to larger monolayers. . 3 

Figure 1.2.2 - Production of a colloidal monolayer using (a) a spin coating technique, 

(b) Doctor Blade trough, (c), and a Langmuir-Blodgett trough. ............................................. 4 

Figure 1.2.3 - Schematic of surfactant molecules and PS micelles in aqueous solution 

[61] ......................................................................................................................................... 5 

Figure 3.1 - Close-packing hexagonal geometry and the relation between the sphere size 

and the corresponding honeycomb structure with surrounding particles. ................................ 9 

Figure 3.2 - Schematic diagram showing an arrangement of perfect hexagonally close-

packed colloidal monolayer structure. The numbers inside each circle indicate its distance from 

the central sphere (between centroids). [70] .......................................................................... 10 

Figure 3.1.1 – (a,b) SEM images of the deposition of 1.3 µm PS nanospheres in PET-

ITO using a conventional LB method; (c) Fast Fourier Transform of SEM image b (d) Radial 

profile plot of the FFT image: normalized integrated intensity as a function of distance (the 

number of spheres diameters) ............................................................................................... 11 

Figure 3.2.1 – Top (left) and side-view (right) of a turbid self-assembly aqueous 

subphase, a condition observed for both 0.5 and 0.6 µm PS nanospheres - a sign of sinking 

colloidal particles and absence of interfacial monolayer formation ........................................ 13 

Figure 3.2.2 – Top and side views on the (a) floatation and self-assembly study for petri 

dish simulations on the deposition of 0.6 µm PS nanospheres on aqueous subphase without 

adding SDS and (b) adding a small concentration of SDS (4.5 mg/l). Turbid subphase and 

colloidal precipitation were observed within the conventional method, while the addition of a 

small amount of SDS developed bright colorful interfacial clusters, well defined in thickness 

and surface. .......................................................................................................................... 14 

Figure 3.2.3 - Petri dish simulation of five different PS:ethanol proportions with 0.6 µm 

PS nanospheres: (a) 2:1; (b) 1:1; (c) 1:2; (d) 1:3; (e) 1:4 ....................................................... 15 

Figure 3.3.1 - SEM images of the PS nanosphere size variation effect: (a,b) for 0.6 µm; 

(c,d) for 0.7 µm;.................................................................................................................... 16 

Figure 3.3.2 - Fast Fourier Transform of the SEM image and radial profile, respectively, 

for 0.6 (a,b) and 0.7 µm (c,d) PS nanospheres. ..................................................................... 17 

Figure 3.3.3 - SEM images of 0.6 µm PS nanospheres depositions with different solvents: 

(a,b) ethanol; (c,d) diacetone ................................................................................................ 18 



 

 
xvi 

Figure 3.3.4 - Fast Fourier Transform of the SEM image and radial profile for each 

solvent for 0.6 µm PS nanospheres depositions - ethanol (a,b) and diacetone (c,d). .............. 19 

Figure 3.3.5 - SEM images of 0.6 µm PS nanospheres depositions using a 1:3 proportion 

in ethanol for different SDS concentrations in the subphase, respectively: (a,b) 3 mg/l; (c,d) 

4.5 mg/l; (e,f) 6 mg/l ............................................................................................................ 20 

Figure 3.3.6 - Fast Fourier transform and radial profile of 0.6 µm PS nanospheres 

depositions using a 1:3 proportion in ethanol for different SDS concentrations in the subphase, 

respectively: (a,b) 3 mg/l; (c,d) 4.5 mg/l; (e,f) 6 mg/l 6 mg/l .............................................. 21 

Figure 3.3.7 – Resulting typical defected substrates after the previous Langmuir-

Blodgett 0.6 µm PS nanospheres depositions: the achieving of a direction-oriented colorful 

pattern (see Google Drive video 8) areas indicate the attaining of a high-ordered layer, whereas 

ACS is higher; on the other hand, the more transparent/whitish areas indicate a low-quality 

deposition, which should reveal disordered nanosphere clusters, therefore, low substrate area 

uniformity. ............................................................................................................................ 22 

Figure 3.3.8 - 0.6 µm PS nanospheres deposited substrates for strategy A (left) and 

strategy B (right): both the full barrier closing and the use of an ethanol underlayer produce 

substrates that show remarkable higher deposition substrate deposition coverages, with reduced 

defect signs. – see Google Drive video 8 ................................................................................ 23 

Figure 3.3.9 - SEM images, fast Fourier transform and radial profile plot of the two 

additional approaches, respectively: (a,b,e,f) strategy A - barrier closing variation and (c,d,g,h) 

strategy B - ethanol underlayer deposition – for 0.6 µm PS nanospheres depositions ............ 24 

Figure A.1 - ImageJ user interface............................................................................. 35 

Figure A.2 - Cropped and scale SEM image in ImageJ .............................................. 35 

Figure A.3 - Image Threshold tool being performed onto the SEM image ................. 36 

Figure A.4 - (a) Binary mask of the SEM image array; (b) Fast Fourier Transform of 

the same image ..................................................................................................................... 36 

Figure A.5 - Radial profile plot: a plot of normalized integrated intensities in the 

function of the distance as the number of full sphere diameters ............................................ 37 

 

 



 

 
xvii 

List of Tables 

Table 3.3.1 – Effect of the addition of SDS (4.5 mg/l) in the monolayer self-assembly 

and substrate deposition for each PS nanosphere diameter ................................................... 16 

Table 3.4.1 - Overall results and performance indicators attained within this work ... 25 

  



 

 
xviii 

 



 

 
xix 

Abbreviations 

ACS – Area Coverage Success 

CL – Colloidal Lithography 

EtOH – Ethanol 

FFT – Fast Fourier Transform 

FFT-R – Number of rings in the FFT 

FoM – Figure of Merit 

IPA – 2-propanol  

IR – Infrared 

ITO - Indium Tin Oxide 

LB – Langmuir-Blodgett 

LT – Light-Trapping 

NaCl – Sodium Chloride 

PET - Polyethylene terephthalate 

PS – Polystyrene 

PSC – Perovskite Solar Cell 

PV – Photovoltaic 

RIE – Reactive Ion Etching 

TCO – Transparent Conducting Oxide 

TiO2 – Titanium Dioxide 

SAC – Substrate Area Coverage 

SDS – Sodium Dodecyl Sulfate 

SEM – Scanning Electron Microscopy 

UV – Ultraviolet 



 

 
xx 

  



 

 
xxi 

Symbols 

µm – Micrometer 

nm - Nanometer 

mm –Millimeter 

cm – Centimeter 

µL – Microliter 

L – Liter 

mg –Milligram 

mL – Milliliter  

s – Second 

I – Intensity of the highest peak of the radial function 

R – Regularity Ratio 

W1/2 – Width at half-height of the highest peak of the radial function 

 

  



 

 
xxii 

 



 

 
xxiii 

Motivation and Objectives 

The pursuit for ever more efficient, reliable, and affordable solar cells has increased 

demand for high-performance light-trapping strategies, capable of boosting their photovoltaic 

performance without significantly increasing costs [1–3]. It has been recently shown that the 

best-performing optical schemes make use of microstructures on the solar cells with features in 

the wavelength scale, as suggested by simulation work, therefore operating in the preferential 

wave-optical regime for photonic enhancement. 

Colloidal lithography [4,5] is an incredibly promising approach for the micro and 

nanofabrication of photonic and photovoltaic applications. It is an especially interesting 

approach since it employs the use of a colloidal patterning mask, which can pattern any 

material yet not being affected by common limitations of other costly and complex structuring 

methods. With that in mind, this work aims to optimize the self-assembly and deposition of 

wavelength-sized nanospheres for colloidal lithography purposes. As this range of sizes does not 

usually show spontaneous air-water interface self-assembly, attaining a good, stable polystyrene 

nanosphere monolayer would be our first goal for colloidal lithography deposition. 

The Langmuir-Blodgett method [6] combines rapid deposition times with versatility and 

scalability that are headmost characteristics for the fabrication of high-quality 2D and 3D 

crystalline films. Unlike other deposition methods like spin-coating or doctor blading, 

Langmuir-Blodgett resulting thin-films tend to show high-uniformity, in which the formation 

of a monolayer is more accurately assured. Specific parameters like the nanosphere size, solvent, 

solvent proportion, and SDS concentration can be studied to further optimize both self-

assembly and deposition steps. 

The monolayer self-assembly can be attained due to the use of anionic surfactants, in 

this case, sodium dodecyl sulfate [7,8]. Anionic surfactants are mostly skin and eye irritating, 

however, the use of very low concentrations should not be a problem. The development of a 

simple, low-cost approach is guaranteed with the Langmuir-Blodgett trough method 

optimization, as the most significant barrier for light-trapping schemes is its usual 

incompatibility with photovoltaic process technology for mass production. 

Concerning the monolayer deposition and substrate transfer, as the size range is quite 

small, one should consider the fine-tuning of surface tension, as well as dipper and barrier 

moving rates, helping isolated nanosphere beads to merge and form a stronger, excellent film 

that does not deteriorate when transferring to the substrate. 
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Chapter I: Introduction 

1.1. Photovoltaic light-trapping technologies 

Improving the quality of life worldwide creates an exponentially increasing need for 

energy. Highly efficient renewable energy sources and storage devices are needed to deal with 

such expensive demands. Considering the depleting fossil fuel stock and the devastating effects 

of global warming, photovoltaic (PV) technologies become one of the leading contenders in this 

field, as it offers a broad diversity of devices – each with their potential use and functionality 

[9–12]. Reports by SolarPower group (2020) [13] have also shown that the solar energy industry 

has a yearly net power generating added capacity as close as half of the total along with other 

sources. 

Thin-film PV devices enable fast and cheap production methods, such as flexible roll-

to-roll processes [14–16]. Moreover, these thin devices also benefit from lower material usage 

and thence further cost reduction. These are crucial factors at the industrial level for efficient 

production, making the technology attractive for application in affordable solar-powered 

consumer products such as mobile electronics (e.g. wearable PV), intelligent packaging (e.g. 

smart labels), IoT, and portable medical diagnostic services [2,3,17–21]. Thickness reduction 

also increases open-circuit voltages (and consequently efficiencies) due to lower bulk 

recombination.  

The solar cells' efficiency is inherently limited by the absorber material's bandgap, as 

it sets the lower energy limit for absorption [22]. Nevertheless, thin-film PV suffers from 

additional absorption losses from the smaller travel path of light within the thin absorber film 

[23]. To overcome the second drawback, advanced light-management techniques must be used 

to improve the device’s optical response. Among these, light-trapping (LT) architectures that 

create challenging conditions for light to escape the device have been the topic of many studies 

[1,24,33–37,25–32]. To improve PV devices' performance, one must adjust the thickness of the 

light-harvesting and charge-transporting layers. The development of new active materials and 

photonic structures, implemented via nano-patterning methods [38,39], has been key to 

improving overall performance, such as extending the absorption onset to the red region of the 

solar spectrum [40].  

Soft-lithography techniques have since been employed, such as colloidal lithography 

(CL), as it that can be adapted to precisely nano/micro-pattern any material with the 

dimensions appropriate for efficient LT and implemented in any type of solar cell with different 

absorbers [31]. S. Haque et al. (2019) [4] has brought the concept of photonic LT structures to 

the emergent and highly promising class of perovskite solar cells (PSC’s). For that, an inverted 

(substrate-type) PSC architecture with wave-optical structures is considered to allow the 

integration of the LT structures as a post-process on the cells’ front contact. With the front-

located wavelength-sized LT structures, higher PSC improvements were envisaged, avoiding 
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increasing the absorber layer roughness, thence avoiding electrical losses due to increased 

recombination. In particular, the optimized titanium dioxide (TiO2) void arrays, which were 

shown to be optically favorable when compared with the domes, enable photocurrent 

enhancements of over 21 % in PSCs with 250 and 500 nm perovskite layer thicknesses. On the 

other hand, M. Alexandre et al. (2019) [30] also presented an interesting conceptual approach 

to exploit UV energy in photonic-enhanced PSCs via the combined effects of LT and 

luminescent down-shifting (LDS). Subsequent research by Sanchez-Sobrado et al. [31,39,41] has 

revealed outstanding results of thin-film solar cells enhanced with photonic front structures 

that were patterned via LB. Using this CL method, highly uniform TiO2 nanostructures were 

attained via the production of LB-deposited colloidal masks (Figure 1.1.1). 

 

Figure 1.1.1 - Schematic drawings and SEM pictures of the samples obtained after the 

different steps of the TiO2 nanostructure construction via CL: (a) a hexagonal array of 

colloidal PS spheres is patterned on the cell front, (b) O2 dry etching, (c) TiO2 is 

deposited, filling the inter-particle spaces, (d) sphere are removed leaving an array of 

semi spheroidal void-like features. The final TiO2 structure, (e) uniformly covers the 

entire sample area. [39] 
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1.2. Colloidal lithography approach 

Colloidal lithography (CL) [1,4] is presently considered the most promising nano/micro-

structuring method for photonic and PV applications [31]. It is an especially interesting 

approach since it can pattern any material and is not affected by common limitations of 

nanoimprinting lithography or photolithography. It consists of four main stages (see Figure 

1.1.1): the colloidal deposition, the patterning mask production via RIE, the deposition of the 

patterning materials (such as TiO2 [39,41], AZO [1] or IZO [31,41]), followed by the final 

nano/micro-structure production after colloidal lift-off [1]. This shows the high versatility of 

this method for implementation in various applications. The most synthesized particle materials 

for use in CL are polystyrene (PS), polymethyl methacrylate (PMMA), and silica. The choosing 

of the preferred sphere surface chemistry depends on the desired application. [42,43] 

1.2.1. Colloidal self-assembly and monolayer formation 

The self-assembly of colloidal particles, which is believed to be a key technology for 

next-generation surface and volume nanostructuring applications [44–48], is a process in which 

colloidal particles spontaneously arrange into ordered superstructures (Figure 1.2.1) [49]. Based 

on the type of dominant force driving the self-assembly, these methods can be organized into 

four classes: physical (process dominated by shear forces, adhesion, and surface structuring), 

fluidic (by capillary forces, evaporation, surface tension), external fields (by electric and 

magnetic fields) and chemical (by chemical interaction, changing the surface charge or creating 

binding sites) [49,50]. 

 

Figure 1.2.1 – 3D illustration of the self-assembly of colloidal particle structures forming 

a hexagonal close-packed array (also known as honeycomb), which results in the highest 

in-plane packing density – single particles tend to bond with others due to either physical, 

fluidic, external fields, or chemical force driving, from single, to small clusters to larger 

monolayers. 
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1.2.2. Substrate deposition of colloidal monolayers 

Three techniques should be emphasized when transferring the monolayer to the desired 

substrate (see Figure 1.1.1a). The spin coating technique (Figure 1.2.2a) can be considered a 

simple process for rapidly depositing thin coatings onto relatively flat substrates [66–69]. The 

doctor blade technique (Figure 1.2.2b) is also simple, and highly-scalable, however, it is quite 

difficult to attain a purely 2D thin-film [51]. However, the resulting thin-films tend to be less 

uniform than those produced by dip-coating methods like Langmuir-Blodgett, in which the 

formation of a monolayer is more accurately assured yet simple to scale to industrial levels. 

[52] 

 

Figure 1.2.2 - Production of a colloidal monolayer using (a) a spin coating technique, 

(b) Doctor Blade trough, (c), and a Langmuir-Blodgett trough. 

Langmuir-Blodgett [53], as described by Figure 1.2.2c, is a simple, low-temperature 

method in which colloidal monolayers [54] can be deposited onto substrates by producing a 

floating monolayer film at the air-water interface (Langmuir-film) and then transferring it onto 

a solid substrate [55]. At first, the amphiphilic colloidal particles are dispersed in a volatile 

water-immiscible solvent (ethanol, diacetone, chloroform, benzene, among others [56,57]) to 

prepare the colloidal solution. Then, small amounts of the solution are carefully deposited and 

spread onto the air-water interface at the LB trough using, for instance, a microsyringe. 

Afterward, the colloidal particles spread throughout the interface on the trough, and the 

volatile solvent evaporates, leaving a colloid monolayer at the interface [58]. Finally, the 

immersed substrate is withdrawn vertically from the aqueous subphase while the lateral barriers 

close in towards the substrate, at controlled rates, thereby transferring the colloids stabilized 

at the air/water interface to the upwards moving substrate [53], resulting in a successfully 

deposited monolayer colloidal film [6]. 

The fabrication of monolayers by interface coating methods as LB has been subject to 

numerous studies, varying the colloids' size, the solution amount and proportion, temperature, 

deposition angle, and others [8,24,59]. Surface and interface chemistry is of paramount 
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importance for defining how smaller particles float and get packed [8,38,60]. For instance, 

smaller particles (under 1 µm) tend to sink into the aqueous subphase, contrasting with larger 

ones that typically float [1,7,8,31]. It is believed that the use of surfactants in the aqueous 

subphase may enhance the floating and film production of colloidal particles at the air/water 

interface, with larger areas and mechanical strength [7,8,60]. Surfactant molecules tend to 

occupy the media interfaces and join the incoming colloidal particles together, thus opposing 

their dispersion caused by the Brownian motion (Figure 1.2.3). The surface assembly forces 

tend to enlarge the array area, increasing the monolayer order and coverage [59,61]. There is 

also a reduction of surface tension at the interface due to the presence of the surfactant, which 

favors colloidal particle movement along the interface to find their lowest energy configuration, 

resulting in an optimally-ordered hexagonal close-packed monolayer [62]. Adding a surfactant, 

however, may introduce undesired contamination to the interface [7,63]. 

 

 

Figure 1.2.3 - Schematic of surfactant molecules and PS micelles in aqueous solution 

[61] 

Vogel et al. (2011) [8] described that small amounts of SDS at the interface influence 

capillary forces and form a soft barrier that facilitates the crystallization process. Furthermore, 

when carboxylic acid-functionalized colloids were used for the monolayer crystallization, an 

increase in the pH of the subphase was found to increase the order in the resulting monolayer. 

The author also increased the aqueous sub-phase pH to 11, which improved the monolayer 

quality. On the other hand, Ye et al. (2017) [7] introduced a simple approach to produce high-

quality hexagonally ordered arrays of polystyrene (PS) microspheres via an air-water self-

assembly method, in which SDS was added to the self-assembly aqueous subphase to change 

the water surface tension.  
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Chapter II: Experimental 

The production of nanosphere-coated substrates followed a procedure in which the 

monolayer self-assembly and its transfer to the substrate were studied sequentially. The full 

production technique is described in this section. Steps 2.3 and 2.4 were previously simulated 

in Petri dishes to allow the further LB deposition of the best self-assembly films. Short, 

numbered videos were recorded to illustrate some of the key aspects of the method below and 

included in the following Google Drive URL: https://bit.ly/3ob1Jlo. 

 Langmuir-Blodgett trough 

For the LB method, introduced in Section 1.1.2, we used the KSV NIMA LB equipment. 

Based on the approach of Ariga et al. (2013) [6], the barriers and the trough were well clean 

with ethanol and deionized water. Then, we carefully filled the trough with 750 ml of deionized 

water. Two substrates were stuck together back-to-back and lowered diagonally. When 

lowering, the dipper zero was set right before contact between the substrates and the air-water 

interface. The barriers were then closed at their maximum, where the barrier zero was set. 

 Substrate preparation 

A4 sheets of PET, with ITO deposited onto one of its faces, were cut into square 

substrates of 2.5 cm × 2.5 cm, then rubbed with detergent and dipped in acetone, IPA, and 

deionized water for 10 minutes using a sonication bath. The substrates were dried using a flow 

of compressed nitrogen and then subjected to exposition to UV-Ozone for 15 minutes for 

wetting enhancement. 

 Aqueous sub-phase preparation 

Inspired by methods developed by Vogel et al. (2011) [8] and Ye et al. (2017) [7], 3.5 

mg of SDS were carefully added using a lab spatula, and spread in the aqueous subphase, to 

attain variable concentrations of 4.5 mg/l, respectively. The surface tension was calibrated to 

be less than 0,8 mN/m and the barriers were slowly open at the lowest manual speed (10%) 

till the maximum opening distance. Using a microsyringe, 1 ml volume of ethanol was added 

to the whole water surface to facilitate further colloidal dispersion. 

 PS nanospheres preparation 

Firstly, a commercial nanosphere aqueous solution (microParticles GmBH PS-R-0.6, 5 

wt%) was agitated for 60 seconds in an MS-X Vortex Mixer. Using a micropipette, a 

nanospheres volume of 200 µl was firstly cast onto an Eppendorf, with a non-polar solvent 

(either pure ethanol - EtOH 95.0% - diacetone, or chloroform). This proportion was defined as 

1:3. Finally, the solution is again submitted to 60 seconds in the MS-X Vortex Mixer. 

https://bit.ly/3ob1Jlo
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 PS nanospheres deposition 

Using a microsyringe, the PS-ethanol solution was carefully and slowly cast to the air-

water interface, guaranteeing the best possible interfacial spreading (see video: 

https://bit.ly/3af35rX). To join separated grains, the barriers were set to be closing at a certain 

rate till a target surface tension (threshold) was met (video: https://bit.ly/2K5lWuy). The 

closing rate was chosen to be fast at first (50 mm/min for a starting 40% progress) to avoid 

fast solvent evaporation from single beads, which would prevent their desired merge. The speed 

would then be reduced up to 10 min/min until a high-quality and colorful thin film was 

observed (video: https://bit.ly/34aGau1). When that condition was met, the target threshold 

was set to 0 to initiate both the dipper raise and barrier closing at a fixed rate of 2 mm/min, 

fully transferring the forming monolayer to the substrates (video: https://bit.ly/34cIcd3). 

 Characterization - SEM and ImageJ 

Surface morphology analysis was performed while using the SEM Hitachi T3030 Plus 

Tabletop equipment, available at CENIMAT|i3N, at a constant accelerating voltage of 15 kV. 

Magnifications in the range of 1000x-8000x were used to produce the resulting SEM images. 

To compare contrasting samples, the same contrast and brightness conditions were applied. 

Recurring to the same SEM imagery, one was able to evaluate the quality of the close-

packing of the nanosphere structure and the substrate area coverage (SAC) by using the Image 

Threshold, Fast-Fourier Transform (FFT), and Radial Profile analysis tools and plugins of the 

ImageJ software, according to work by several authors [65-60,72]. Both the software and the 

plugins were downloaded from its official website (https://imagej.nih.gov/ij/download.html). 

Performing an Image Threshold selects the brighter pixel areas (which show the 

deposited nanospheres domains) and reflects its total SAC [64–66]. On the other hand, the 

FFT function consists of the graphical representation of the previous grayscale image in the 

frequency domain, thus displaying the structure ordering. As far as the Radial Profile plugin 

is concerned, it produces a profile plot of normalized integrated intensities around concentric 

circles as a function of distance. In this work, the distance was presented as a factor of the 

minimum distance between close-packed spheres (which is equal to the sphere diameter) to 

compare to the values suggested further in Figure 3.2. 

More information on the ImageJ characterization can be found in Appendix A, as a 

simpler method was developed to only use ImageJ throughout the whole analysis. 

https://bit.ly/3af35rX
https://bit.ly/2K5lWuy
https://bit.ly/34aGau1
https://bit.ly/34cIcd3
https://imagej.nih.gov/ij/download.html
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Chapter III: Results and Discussion 

This chapter intends to discuss the optimization of the different parameters that were 

studied to improve the colloidal monolayer quality, such as the polystyrene (PS) nanospheres 

sizes, the solvent and its proportion in the colloidal solution, and the sodium dodecyl sulfate 

(SDS) concentration in the Langmuir-Blodgett (LB) aqueous sub-phase. The quality of the 

self-assembly was evaluated by the exhibition of a uniform colorful refraction pattern at the 

air-water interface (mostly via a petri dish simulation of the LB trough). As far as the LB 

deposition is concerned, a good substrate coverage is desired, while it is also expected to achieve 

excellent area-uniform close-packed honeycomb structures, inspected by scanning electron 

microscopy (SEM) and ImageJ tools – Image Threshold, Fast Fourier Transform (FFT) and 

Radial Profile. 

The Image Threshold allows for the extraction of the surface area coverage (SAC) 

of each deposition. Its maximum value (SACMAX) can be calculated following the relation 

between the area occupied by perfectly close-packed spheres and the total available area (Figure 

3.1).  

𝑆𝐴𝐶𝑀𝐴𝑋  (%) =
1 + 6/3 𝐶𝑖𝑟𝑐𝑙𝑒 𝐴𝑟𝑒𝑎

1 𝐻𝑒𝑥𝑎𝑔𝑜𝑛 𝐴𝑟𝑒𝑎
=  

3(𝜋 ∗ 𝑟2)

3 (2𝑟)2√3

2

=
𝜋

2√3
~ 90.7% 

 

Figure 3.1 - Close-packing hexagonal geometry and the relation between the sphere size 

and the corresponding honeycomb structure with surrounding particles. 

Here we define the Area Coverage Success (ACS = SACEXP/SACM AX) as the 

ratio between the experimental SAC value, obtained for each deposition with Image Threshold, 

and the theoretical maximum SAC value of 90.7%. 

By applying the Fast Fourier Transform  (FFT) to the scanning electron microscopy 

(SEM) images for each batch of samples, it was possible to perceive the long-range ordering 

and its quality. The FFT function consists of the graphical representation of the previous 

grayscale image in the frequency domain in respect of its structure ordering, allowing for the 

numerical representation of contrasting FFT images. This tool establishes a relation between 

a central particle and its surroundings, as in a perfect close-packed structure we would follow 

a model pattern of distances (depicted in Figure 3.2). An ordered array should show bright and 
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clear peaks positioned within a hexagonal shape, coinciding with the surrounding particles 

centroids, while an unordered array would be represented by fading concentric circles or rings 

[66–69]. On the other hand, a good FFT peak definition can also be related to how much the 

array resembles a honeycomb structure. The FFT imagery also provides crucial information 

regarding directional structure ordering. Pixel intensities were summed along a radius from the 

center to the edge of the image to quantify the relative contribution of objects oriented in that 

direction. The number of rings (FFT-R) relates to the uniformity throughout the analyzed 

area – it can be defined as the number of reasonably focused concentric circles in the FFT 

image. The larger the value of FFT-R, the better the periodicity among the total area [69]. 

 

Figure 3.2 - Schematic diagram showing an arrangement of perfect hexagonally close-

packed colloidal monolayer structure. The numbers inside each circle indicate its distance 

from the central sphere (between centroids). [70] 

To quantitatively analyze the quality of particle arrangement, we used the radial 

distribution function (Radial Profile), which is a mathematical function that gives the 

probability of finding a particle at a certain distance from a reference particle [70]. This function 

has been used to describe the characteristic of the lattice structure in solids through the 

positions, separations, and heights of the distinct sharp peaks. It consists of plotting the angle 

integrated FFT as a function of the distance (radius) to a central point in the image. Such 

analysis transforms the 2D FFT into a 1D function with a single variable, thus assisting in the 

assessment of the resulting order and deposition quality. To prevent any effects that 

magnification and sphere size variation may have in further radial profile comparisons, an 

additional step was employed: the normalized integrated intensity was defined as a function of 

distance (as a factor of the sphere diameter). The schematic displayed in Figure 3.2 shows the 

fraction of the diameter that represents the distances between the centroids of close-packed 

particles. The resulting plot of a perfect arrangement shows multiple peaks at the distances 1, 
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√3, 2, √7, 3, 2√3, √13, 4 times the distance between close-packed spheres centroids [69]. Also, 

the more, intense, distinct, and narrower Radial Profile peaks, the better arrangement, as it 

indicates that the expected intersphere distances are fulfilled along the analyzed area [71]. 

 PS nanospheres deposition (1.3 µm size) 

Polystyrene nanospheres have been shown to typically float when deposited onto the 

air-water interface, however sinking effects are observed when depositing smaller spheres. A 

simple, conventional LB method [39] was used to deposit a honeycomb array of 1.3 µm diameter 

polystyrene nanospheres in flexible substrates. Self-assembly occurred naturally at contact with 

the air-water interface, and a fully deposited substrate was achieved. 

 

Figure 3.1.1 – (a,b) SEM images of the deposition of 1.3 µm PS nanospheres in PET-

ITO using a conventional LB method; (c) Fast Fourier Transform of SEM image b (d) 

Radial profile plot of the FFT image: normalized integrated intensity as a function of 

distance (the number of spheres diameters) 

After contrast increase and threshold definition, the ImageJ analysis resulted in a SAC 

of 80%, which should translate, according to the maximum value of 90.7% calculated in this 

chapter’s introduction, to an ACS of 88.2%. The FFT image (Figure 3.1.1c) shows several well-
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defined peaks, which is a sign of being in the presence of a periodic structure [69]. A total of 6 

contrasting rings are suggested by both Figure 3.1.1c and the plot in Figure 3.1.1d, with 6 

peaks – the larger the number of rings, the better the periodicity among the total area [69]. 

Multiple radial profile peaks were clearly seen at approximately identical positions (Figure 

3.1.1d) as expected in Figure 3.2, indicating a good arrangement quality. However, as it is 

possible to witness in the FFT image, the π/3 direction peaks lose definition as the distances 

grow larger. Good overall periodicity and close packing were achieved within these structures, 

with very small directional disordering. For 1.3 µm nanospheres, in similarity with larger ones, 

it was perceived that a conventional LB method was naturally capable of resulting in high-

quality arrays. This experiment was intended to better understand the results that one should 

aim for when producing state-of-art nanospheres arrays using smaller sizes, this work’s main 

goal. 

 PS nanospheres self-assembly (below 1 µm size) 

Although the deposition of PS sizes of 1.3 µm is well-succeeded within conventional 

Langmuir-Blodgett self-assembly and substrate dipping methods, its use with smaller colloid 

sizes did not manage to provide reasonable results. According to the simulation studies 

performed by the PV research team of CEMOP and CENIMAT|i3n [29,30], the preferential 

dimensions of the CL patterns should be within the 0.5-1 µm range for the thin-film solar cell 

technologies analyzed (namely based in silicon, perovskite, or CIGS PV materials). On the 

other hand, the team’s experimental results also showed that a high-quality deposition with 

smaller PS nanospheres (below 1.3 µm) would be especially challenging since the conventional 

method would not provide for their spontaneous floatation for the monolayer self-assembly in 

Langmuir-Blodgett. Therefore, this was a key issue addressed in this thesis, aiming for the 

controlled deposition of PS sphere arrays with sizes in the preferential 0.5-1 µm range. After 

guaranteeing the floatation of these smaller nanospheres, optimizing the production of a high-

quality film and its deposition onto flexible substrates would be key for a good performance. 

3.2.1. Preliminary PS nanospheres self-assembly experiments 

At first, the conventional self-assembly approach described in the previous section was 

reproduced in Petri dishes to study the spontaneous self-assembly of 0.5 and 0.6 µm 

nanospheres. However, no nanosphere floatation could be found in the presence of the proposed 

1:3 ethanol colloidal solvent, as the simulated aqueous subphase would become turbid and 

therefore one could conclude the nanospheres had sunk (Figure 3.2.1).  
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Figure 3.2.1 – Top (left) and side-view (right) of a turbid self-assembly aqueous subphase, 

a condition observed for both 0.5 and 0.6 µm PS nanospheres - a sign of sinking colloidal 

particles and absence of interfacial monolayer formation 

This same outcome was reported for both 0.5 and 0.6 µm nanosphere sizes. Although 

further testing was performed by varying the solvent (ethanol, diacetone, chloroform, among 

several others) and the PS-solvent proportion (1:2, 1:3, and 1:4), better results could not be 

achieved. It was not possible to detect a colorful film forming at the interface, as suggested in 

the Materials and Methods chapter. The inclusion of a centrifugation step, in which the initial 

nanosphere aqueous solution would be dried off in four centrifugation cycles, showed small 

improvements in the self-assembly - by fixing a 1:3 proportion of either ethanol or diacetone, 

one could witness the forming of very weak interfacial film, that would sink rapidly. 

3.2.2. Surfactant addition on the self-assembly aqueous subphase 

Following the premise that the use of surfactants, such as SDS, in the self-assembly 

aqueous subphase would prevent sinking effects [7,8], small amounts (4,5 mg/l) of SDS were 

dissolved before the nanosphere microsyringe dropping onto a sliding glass, to prevent heavy 

drops. A PS-ethanol proportion of 1:3 was fixed in this experiment. In any of the tested 

concentrations of 3 mg/l, 4.5 mg/l, and 6 mg/l and nanosphere sizes of 0.5 and 0.6 µm, the 

addition of SDS showed significant improvement in the spontaneous nanosphere floatation and 

self-assembly, with small sinking loss when compared to conventional LB methods (Figure 

3.2.2).  
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Figure 3.2.2 – Top and side views on the (a) floatation and self-assembly study for petri 

dish simulations on the deposition of 0.6 µm PS nanospheres on aqueous subphase without 

adding SDS and (b) adding a small concentration of SDS (4.5 mg/l). Turbid subphase 

and colloidal precipitation were observed within the conventional method, while the 

addition of a small amount of SDS developed bright colorful interfacial clusters, well 

defined in thickness and surface. 

However, sinking effects would be fastened and highly induced by reducing or increasing 

the SDS concentration. As reported in the Introduction chapter and depicted in Figure 1.2.3, 

the use of surfactants in a gas-liquid interface creates a surfactant thin layer with the 

hydrophilic tail towards the water and the hydrophobic tail towards the air. In this case, when 

contacting with the interface, the non-polar solvent dissolved polystyrene spheres would spread 

on top of this layer easily. The excessive concentration of SDS would induce the formation of 

micelles, which would bring the nanospheres clusters into sinking – which could be seen in both 

top and side views of the petri dish after some resting minutes. On the other hand, using a 

smaller concentration would tend for a lacking floatation effect, as seen in the previous section. 

It is also natural to observe the formation of isolated nanosphere clusters, as this is a simulation 

of the LB trough and therefore it lacks the barrier closing effect on its merging. 

NaCl was also tested as a sub-phase specimen, as proposed in a work by Moon et al. 

(2011) [72], in which the concentration of 10 g/l was used hoping to attain decent floating and 

self-assembly properties. Within this work, average, and border concentrations of 5 g/l, 10 g/l, 

and 100 g/l were studied, however, none would provide any sort of floatation enhancing effect 

and all particles sunk. 
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3.2.3. Nanosphere/solvent proportion variation 

In this next set of experiments, the mixture of the original commercial nanosphere 

solution and the main solvent was tested to be 2:1, 1:1, 1:2, 1:3, and 1:4 (Figure 3.2.3 and 

Google Drive: https://bit.ly/3mi0Kyw). In this experiment, fixed conditions were a 4,5 mg/l 

concentration of SDS (sodium dodecyl sulfate), ethanol as a solvent, and 0.6 µm PS 

nanospheres. 

   

  

Figure 3.2.3 - Petri dish simulation of five different PS:ethanol proportions with 0.6 µm 

PS nanospheres: (a) 2:1; (b) 1:1; (c) 1:2; (d) 1:3; (e) 1:4 

As seen in Figure 3.2.3, there is a tendency among the first four proportions, which 

could mean that an increase in the solvent volume could improve the interfacial monolayer 

assembly. However, as noticed in Figure 3.2.3e, the excessive use of ethanol (solvent) fastens 

the degradation of the monolayer clusters, mainly due to the strong interaction between ethanol 

and SDS. In reasonable smaller volumes, ethanol slows down the degradation reaction and 

hence contributes to a long-lasting self-assembly monolayer. A 1:3 proportion was therefore 

kept as the most promising for further experiments. 

Since the achieving of a spontaneous floatation and self-assembly of polystyrene 

nanospheres was our first main goal, we were then in conditions to proceed for its reproduction 

in the Langmuir-Blodgett trough. 0.5 µm sized nanospheres were then discarded from further 

studies due to its lacking quantity and sizes up to 1.0 µm still being optimal in light-trapping 

applications. 

https://bit.ly/3mi0Kyw
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 PS nanospheres deposition (below 1 µm size) 

3.3.1. Size-variation effect on the PS nanospheres deposition 

Different PS nanosphere diameters 0.6 µm, 0.7 µm, and 0.9 µm were tested while fixing 

the best performing conditions at 1:3 proportion, ethanol as a solvent, and a sub-phase SDS 

concentration of 4.5 mg/l (Figure 3.3.1). These size variations did not seem to a significant 

effect on the monolayer self-assembly, as all three produced stable colorful films. Nevertheless, 

0.9 µm deposited substrates shown low substrate deposition, being discarded (Table 3.3.1). 

Table 3.3.1 – Effect of the addition of SDS (4.5 mg/l) in the monolayer self-assembly 

and substrate deposition for each PS nanosphere diameter 

PS Nanospheres 

Size (µm) 

Self-Assembly 

M onolayer Quality 

Substrate Deposition 

Coverage 

0.6 Good Decent 

0.7 Good Decent 

0.9 Decent/Good Bad 

 

Figure 3.3.1 - SEM images of the PS nanosphere size variation effect: (a,b) for 0.6 µm; 

(c,d) for 0.7 µm; 
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Figure 3.3.2 - Fast Fourier Transform of the SEM image and radial profile, respectively, 

for 0.6 (a,b) and 0.7 µm (c,d) PS nanospheres. 

The 0.6 µm ImageJ analysis resulted in a SAC of 60%, which should translate to an 

ACS of 66.2% (Figure 3.3.1a). The FFT image (Figure 3.3.2a) shows low-definition hexagonal 

cycles, with no well-defined peaks being defined. The fact that the hexagonal dispersed FFT 

peaks can be seen is an indicator that some ordering can be found. The radial profile (Figure 

3.3.2b) gives us the information that the average distances from the closest surrounding spheres 

are double than what should be expected, therefore, close packing was not totally achieved. 

Concerning the 0.7 µm sample, the ImageJ analysis resulted in a SAC of 40%, which 

should translate to a smaller ACS of 44.1% (Figure 3.3.1c). Well-defined peaks were also not 

found in the FFT image (Figure 3.3.2c), but the cycles seem to be more of a circular shape 

than for the 0.6 µm samples, more hexagonal. The peaks in the radial profile plot (Figure 

3.3.2d) give us the information that the average distances from the closest surrounding spheres 

are quite near to the expected values. However, with the peaks being small and wide, the 

intersphere distances do not seem to be uniform throughout the analyzed area. 

These results indicate that this method tends to provide better results for 0.6 µm 

spheres, while also not invalidating future studies for 0.7 µm, which shows decent depositions. 
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3.3.2. Solvent-variation effect on the PS nanospheres deposition 

As a solvent for the nanospheres solution, the use of either ethanol or diacetone showed 

similar quality of air-water monolayer formation for a fixed 1:3 proportion, which was revealed 

to be the best performing proportion for both solvents. The SEM results for each batch are 

reported in Figure 3.3.3. 

 

Figure 3.3.3 - SEM images of 0.6 µm PS nanospheres depositions with different solvents: 

(a,b) ethanol; (c,d) diacetone 

The ethanol sample ImageJ analysis resulted in a SAC of 50%, which should translate 

to an ACS of 55.1% (Figure 3.3.3a). Concerning the diacetone sample, the ImageJ analysis 

resulted in a lower SAC of 40%, which should translate to a smaller ACS of 44.1% (Figure 

3.3.3c). 

In Figure 3.3.4 we report the FFT and radial profile plot results for each batch of 

samples. The ethanol-related FFT image (Figure 3.3.4a) shows 3 low-definition rings, with no 

well-defined peaks being defined. This induces the information of low periodicity. Small and 

wide peaks (Figure 3.3.4b), with double than expected distances, show that the spacing is 

higher than it should be, with low-area uniformity. 
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Figure 3.3.4 - Fast Fourier Transform of the SEM image and radial profile for each 

solvent for 0.6 µm PS nanospheres depositions - ethanol (a,b) and diacetone (c,d). 

For the diacetone sample, decent peaks can be seen in the FFT image (Figure 3.3.4c), 

with only 2 visible rings. The same doubled intersphere distance is observed at its radial profile 

(Figure 3.3.4d), while the radial profile peaks tend to be thinner and higher – a sign of distance 

uniformity. This would mean that, in the diacetone sample, the polystyrene dispersion would 

be superior in uniformity and inferior in periodicity than in the ethanol sample. 

According to these results, one can notice that the use of ethanol shows a significant 

uniformity throughout the deposited area, however large honeycomb beads could not be found. 

As far as the diacetone-based samples are concerned, at least half of its surface is high-ordered 

and the self-assembly seemed perfect, yet significant surface area uniformity could not be found. 

 

 

 



 

 
20 

3.3.3. Aqueous sub-phase composition variation 

Although similar testing was completed and reported in Section 3.2.2., the same 

concentrations were tested in the LB trough aqueous sub-phase. The three showed similar self-

assembly performance to the previously tested, however, substrate coverage and the quality of 

the array were now evaluated. This information is also sustained by the SEM imagery (Figure 

3.3.5), as one can see a tendency in the decrease of the honeycomb structure quality with the 

SDS concentration increase. 

 

Figure 3.3.5 - SEM images of 0.6 µm PS nanospheres depositions using a 1:3 proportion 

in ethanol for different SDS concentrations in the subphase, respectively: (a,b) 3 mg/l; 

(c,d) 4.5 mg/l; (e,f) 6 mg/l  
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Figure 3.3.6 - Fast Fourier transform and radial profile of 0.6 µm PS nanospheres 

depositions using a 1:3 proportion in ethanol for different SDS concentrations in the 

subphase, respectively: (a,b) 3 mg/l; (c,d) 4.5 mg/l; (e,f) 6 mg/l 6 mg/l 
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The 3 mg/l concentration sample ImageJ analysis resulted in a SAC of 60%, which 

should translate to an ACS of 66.2% (Figure 3.3.5a). The FFT image (Figure 3.3.6a) shows 3 

low-definition hexagonal rings, yet with no well-defined peaks being defined (Figure 3.3.6b). 

This induces the information of low periodicity. Concerning the 4,5 mg/l concentration sample, 

the ImageJ analysis resulted in a similar SAC of 70%, which should translate to a smaller ACS 

of 77.2% (Figure 3.3.5c). Decent peaks can be seen in the FFT image (Figure 3.3.6c and d). 

Regarding the 6 mg/l concentration sample, the ImageJ analysis resulted in a SAC of 60%, 

which should translate to a lower ACS of 66.2% (Figure 3.3.5e). Low-resolution peaks can be 

seen in the FFT image (Figure 3.3.6e), showing decent periodicity. A small radial distribution 

peak is seen at a doubled position (Figure 3.3.6f). 

As the concentration increases in value, the area uniformity increases while the 

periodicity quality tends to decrease. The three arrays that were described in Figure 3.3.6 

shown light FFT peaks, which are adjusted to a periodic and high-ordered model. Therefore, 

one can notice that the use of an average concentration of SDS (4.5 mg/l) tends to produce 

better and higher-quality self-assembly monolayers. 

Concerning the substrate transferal and deposition, the achieving of a full substrate 

deposition coverage was not guaranteed within the methods described above. Although the 

formation of a high-ordered monolayer was always reported while using the LB trough, the 

transferal to the substrate was not always successful as expected (see Figure 3.3.7). In some, 

the substrate would not be fully deposited while, in others, the film would too thin (displaying 

distant nanosphere clusters), while in most a striped deposition pattern would be observed 

(visible at close looking but could not be photographed). Therefore, additional strategies and 

parameters had to be optimized and developed to improve the substrate deposition quality and 

area uniformity.  

   

Figure 3.3.7 – Resulting typical defected substrates after the previous Langmuir-Blodgett 

0.6 µm PS nanospheres depositions: the achieving of a direction-oriented colorful pattern 

(see Google Drive video 8) areas indicate the attaining of a high-ordered layer, whereas 

ACS is higher; on the other hand, the more transparent/whitish areas indicate a low-

quality deposition, which should reveal disordered nanosphere clusters, therefore, low 

substrate area uniformity. 
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3.3.4. Optimizing the substrate deposition area coverage 

An additional step was introduced at first to cover this issue. The next batches of 

samples were submitted to a sonication treatment with UV-Ozone equipment, as it is known 

to improve surface wettability. Two additional strategies were designed and employed to 

improve close-packing success among the whole area of the substrate. The first – strategy A – 

started with the full barrier closing, disrupting the forming monolayer. A slow opening was 

then performed, with the microsyringe addition of 1 ml of ethanol providing the formation of 

a stronger and brighter 2D film. The second - strategy B - was the deposition of the same 1 ml 

of ethanol just before the nanosphere solution deposition onto the air-water interface, as a 

dispersant underlayer. Both resulting structures are detailed below: Figure 3.3.8 shows the 

resulting deposited substrates and Figure 3.3.9 combines the SEM images on these substrates 

and further ImageJ analysis. 

Figure 3.3.8 - 0.6 µm PS nanospheres deposited substrates for strategy A (left) and 

strategy B (right): both the full barrier closing and the use of an ethanol underlayer 

produce substrates that show remarkable higher deposition substrate deposition coverages, 

with reduced defect signs. – see Google Drive video 8 

Considering the sample produced via strategy A, the ImageJ analysis resulted in a SAC 

of 75%, which should translate to an ACS of 82.7% (Figure 3.3.9a). On the other hand, the 

radial profile function (Figure 3.3.9f) shows 3 small peaks. Regarding the sample produced via 

strategy B, the ImageJ analysis resulted in a lower SAC of 45%, which should translate to a 

lower ACS of 50.0% (Figure 3.3.9c). No decent peaks could be found in either the FFT images 

(Figure 3.3.9e and g), showing weak periodicity. The radial profile plots (Figure 3.3.9f and h) 

show a more defined peak at strategy A, which could reveal better uniformity. Both strategies 

allowed for excellent substrate coverages (Figure 3.3.8). More area uniformity was achieved via 

strategy B, while better close packing was attained with strategy A. 
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Figure 3.3.9 - SEM images, fast Fourier transform and radial profile plot of the two 

additional approaches, respectively: (a,b,e,f) strategy A - barrier closing variation and 

(c,d,g,h) strategy B - ethanol underlayer deposition – for 0.6 µm PS nanospheres 

depositions 
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 Results Overview 

In this section, we compile the previous results for further comparison and discussion, 

which will contribute to the optimization of the procedure depicted in Chapter II. An 

overarching Figure of M erit (FoM) was estimated by correlating the deposition results 

(Area Coverage Success - ACS, the number of FFT rings - FFT-R, and the 

Regularity Ratio - R [66]) with their relevance for future colloidal lithography applications.  

Table 3.4.2 - Overall results and performance indicators attained within this work 

Batch ACS 

(%) 

FFT-R 

(# of rings) 

R 

(a.u.) 

FoM  

(a.u.) 

PS Nanosphere Size Variation 

0.6 µm 66.2% 3 73.3 84,0 

0.7 µm 44.1% 3 32.0 24,4 

0.9 µm No decent deposition was observed. 

PS Nanospheres Solvent Variation 

Ethanol 55.1% 3 25.0 23,9 

Diacetone 44.1% 2 72.0 44,9 

Aqueous Sub-Phase Composition Variation 

SDS (3 mg/l) 66.2% 3 55.0 63,0 

SDS (4.5 mg/l) 77.2% 3 42.0 56,2 

SDS (6 mg/l) 66.2% 3 20.0 22.9 

Substrate Coverage Optimization Strategies 

A. Full LB Closing 82.7% 3 37.5 53.7 

B. EtOH Sublayer 50.0% 2 21.3 15.1 

 

The regularity ratio was calculated for each batch recurring to equation (1) proposed 

by Stępniowski et al. (2014) [66], with I being the intensity of the corresponding highest peak 

in the radial function, and W1/2 is the width of the same radial function peak at half of its 

height. As a ratio between intensity and diameter-factor distances, its units are arbitrary (a.u.). 

𝑅 =
𝐼

𝑊1/2
  (1)                         𝐹𝑜𝑀 = 𝐴𝐶𝑆 ∗ √𝐹𝐹𝑇𝑅 ∗ 𝑅   (2) 
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The overall quality of the resulting structures was quantified with the use of a global 

dimensionless FoM defined in equation (2), which merges the results in a way that the best 

performing structure is easily found and described. Within this work, we desire a high area 

coverage success (~100%), a high number of FFT rings, and a high Regularity Ratio. While 

both the first and the third have a huge impact on the structure quality, the second could be 

seen as an indicative – bearing that in mind, different weights in the FoM expression were 

taken. Therefore, we propose a simple Figure of Merit (2) that evaluates the best performing 

batches. 

The results displayed in Table 3.4.2 show how much the study parameters affected the 

quality and production of flexible nanosphere-coated substrates. The first aspect that can be 

perceived is that the use of this method suits better sizes of 0.6 µm than 0.7 or 0.9 µm. It is 

interesting to notice that the use of diacetone as a nanosphere solvent could improve the 

ordering of the monolayer, so it is an interesting choice for further testing. Regarding the SDS 

concentrations, there is a tendency in having better results in lower concentrations, however, 

for 3 mg/l and 4.5 mg/l the difference does not seem substantial. As time plays an important 

role in the stabilization of the monolayer, we would choose the later concentration as it tends 

to last a bit longer. When optimizing the substrate deposition coverage, an approach that 

includes the full closing of the LB barriers, followed by merging the resulting disrupted 

nanosphere clusters, is expected to introduce a brighter and stronger colloidal monolayer for 

further substrate transfers.  
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Chapter IV: Conclusions and Future Perspectives 

Within this work, an efficient approach for the self-assembly and deposition of 0.6 µm 

polystyrene nanospheres on flexible substrates was successfully attained. This allows for the 

further development of colloidal lithography to produce more efficient photonic wavelength 

sized nanostructures. This experimental approach should provide for a remarkable photovoltaic 

performance boost in the upcoming years, as supported by previous simulation studies. 

The use of a conventional Langmuir-Blodgett deposition method for larger nanospheres 

was optimized for lower sizes. Sodium dodecyl sulfate, at low concentrations in the aqueous 

sub-phase, proved to be an important third-party agent for the technique, as it was shown to 

allow nanosphere floatation and offer good self-assembly results. The use of ethanol as a 

colloidal solvent proved to be decent in quality, while its cost is quite low when compared to 

other possible solvents. A typical 1:3 proportion was also perceived as optimal for balancing 

both floatation improvement and fast sinking effects. Finally, when tested for different 

nanosphere sizes, this method showed better results for 0.6 µm samples, decreasing with larger 

sizes (0.7 and 0.9 µm). The use of sodium chloride within the aqueous subphase to increase the 

subphase density and provide for a stronger air-water interface, reducing sinking effects, failed 

to produce any reasonable results. 

As the stability of nanospheres in air-water assembly methods is naturally quite low, 

future works might be focused on the fine-tuning of the Langmuir-Blodgett trough controls, 

such as rest time, barrier/dipper moving rate, and temperature. The search for other solvents 

and anionic surfactants might also be important, however, as cost takes a huge part in the 

process, this might not be easy to achieve. A variation in the Langmuir-Blodgett aqueous sub-

phase pH could also enhance close-packing, as proposed for spin-coating by Vogel et al. (2011). 

Other dip coating methods could also be the subject of further studies, with the 

substrate tilt, speed rate, temperature, pH, and sub-phase composition taking a major 

optimization opportunity for the production of high-ordered arrays for photonic applications. 

Alternative sphere materials, such as silica, may introduce better uniformity results. Doctor 

blade (or blade coating) is also considered a primary alternative to Langmuir-Blodgett due to 

better scalability possibilities scalable and easier to employ at an industrial level. However, 

viscosity and thickness may constitute a further barrier to the production of better-quality 

films.  
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Appendices 

A. ImageJ analysis 

At first, one needs to import a high-resolution SEM image file (File» Open…) within 

the ImageJ user interface (Figure A.1). This image should be of such magnification that the 

spheres can still be visible, yet the structure is the biggest possible, otherwise, the analysis 

results, as radial function dependent, would tend to be quite small in resolution. 

 

Figure A.1 - ImageJ user interface 

When imported, the image needs to be treated to become a pure black and white array. 

To submit for further FFT and radial profile analysis, the scale should be converted in such a 

way that the abscises become related to the number of close-packed spheres (# of full 

diameters). By selecting the “Straight” selection tool and selecting a straight region on top of 

the SEM scale, one can go to “Analyze» Set Scale” and define the real size and its primary unit. 

Within this step, we selected a single sphere and modeled its real size as 0.3183 # of full 

diameters (0.3183=1/π), to have diameter-based coordinates within the FFT image. The 

extraction of the radial profile from the FFT allows for a global measure, instead of selecting 

any specific circular region within the original SEM image. Therefore, we were in conditions to 

crop the resulting image (Figure A.2), by first selecting the desired area (with the selection tool 

“Rectangle” and then going to “Edit» Crop”). 

 

Figure A.2 - Cropped and scale SEM image in ImageJ 
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From now on, it is our goal to improve the SEM image in a way that single particles 

could easily be distinguished from the background surface and each other. The Image Type 

should be turned to 8-bit (“Image» Type» 8-bit”). For those matters, a combination of high 

contrast (“Image» Adjust» Brightness/Contrast…”) and image blur (Process» Smooth) should 

allow for the Image Threshold analysis (“Image» Adjust» Threshold…”). This analysis gives 

quantitative information on the surface area coverage (SAC) of nanospheres relative to the 

background area (Figure A.3). 

 

Figure A.3 - Image Threshold tool being performed onto the SEM image 

After this analysis, and if the nanospheres are fully covered in a red overlay, one can 

press “Apply” to create a binary mask that turns the image to pure black and white (Figure 

A.4a). The Fast Fourier Transform (FFT) tool can then be applied (“Process» FFT» FFT”), 

providing a correspondent plot (Figure A.4b). 

    

Figure A.4 - (a) Binary mask of the SEM image array; (b) Fast Fourier Transform of 

the same image 
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A Radial Profile plugin was downloaded (Radial Profile Plot (nih.gov)) and installed in 

ImageJ to perform the next step. Its application to the FFT image (“Plugins» Radial Profile”) 

produces a radial profile, a plot of normalized integrated intensities in the function of the 

distance as the number of full sphere diameters (Figure A.5). It is important to tick the box 

“Spatial Calibration” to guarantee the use of the scale and unit defined before. Regarding the 

function itself, the starting point is automatically defined as the center of the rectangle that 

bounds the image, but its position can be modified. The intensity at any given distance from 

the point represents the sum of the pixel values around a circle. This circle has the point as its 

center and the distance from the point as a radius. The integrated intensity is divided by the 

number of pixels in the circle that is also part of the image, yielding normalized comparable 

values. The profile x-axis can be plotted as pixel values or as values according to the spatial 

calibration of the input image, however, as defined in the scaling procedure, it is related to the 

diameter of the spheres for close-packing analysis. 

 

Figure A.5 - Radial profile plot: a plot of normalized integrated intensities in the 

function of the distance as the number of full sphere diameters 

https://imagej.nih.gov/ij/plugins/radial-profile.html

